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Document Introduction 
This document covers the mounting and wiring of the 
FX40 controller. This document also covers the FX40 
software setup. 

 

Figure 1: FX40 

Default Communication and Login Properties 
The new FX40 series controller is pre-configured with 
default properties as defined in Table 1. 

Table 1: FX40 Default Properties 

Name Default Property 
Internet Protocol (IP) 
Address  

192.168.1.149 

Subnet Mask  255.255.255.0 
Default Gateway 192.168.1.1 
Remote User Name jci 
Remote Password explorer 

North American Emissions Compliance  
This equipment has been tested and found to comply 
with the limits for a Class A digital device pursuant to 
Part 15 of FCC Rules. These limits are designed to 
provide reasonable protection against harmful 
interference when this equipment is operated in a 
commercial environment. This equipment generates, 
uses, and can radiate radio frequency energy and, if 
not installed and used in accordance with the 
instruction manual, may cause harmful interference to 
radio communications. Operation of this equipment in 
a residential area is likely to cause harmful 
interference, in which case the user will be required to 
correct the interference at his/her own expense. 

Industry Canada (IC) 
This Class (A) digital apparatus meets all requirements 
of the Canadian Interference-Causing Equipment 
Regulations. 

Cet appareil numérique de la Classe (A) respecte 
toutes les exigences du Règlement sur le matériel 
brouilleur du Canada. 

 Part No. 24-10174-18, Rev.—  



  

Preparation 
Unpack the FX40 and inspect the contents of the 
package for damaged or missing components. If 
damaged, notify the appropriate carrier and return any 
damaged components for repair or replacement.  

Included in this package are the following items: 

• FX40 

• FX40 Installation Instructions 

• hardware bag containing the following items:  

− 499 ohm resistors (quantity 6) 

− 6-position Input/Output (I/O) screw terminal 
connector plugs (quantity 4) 

− 3-position RS-485 screw terminal connector 
plug (quantity 1) 

− wire nuts (quantity 2) 

− 2-position screw terminal connector plug 

• optional items (if ordered): 

− factory installed modem 

Tools Required 
You may require the following tools for installation: 

• 1/4-inch (7 mm) nut driver: used to remove the 
transformer shield 

• small flat-blade screwdriver: used for I/O, RS-485, 
and LONWORKS® connectors. If you remove or 
install the circuit board from the enclosure, a 
1/4-inch thin-walled socket is required (do not use 
a nut driver). See Replacing the FX40 Circuit 
Board. 

Safety Precautions 
The following information relates to the installation and 
startup of the FX40 controller. 

!   Warning: Risk of Electric Shock. 
Disconnect power supply before making electrical 
connections. Contact with components carrying 
hazardous voltage can cause electric shock and 
may result in injury or death.  

 

Important Use copper conductors only. Make 
all wiring connections in accordance with local, 
national, and regional regulations. Do not exceed the 
FX40 electrical ratings. 

 

Important Do not install or use the FX40 in or 
near environments where corrosive substances or 
vapor could be present. Exposure of the FX40 to 
corrosive environments may damage the device’s 
internal components, and will void the warranty. 
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Mounting Important Use this FX40 only as an operating 
control. Where failure or malfunction of the FX40 
could lead to personal injury or property damage to 
the controlled equipment or other property, 
additional precautions must be designed in the 
control system. Incorporate and maintain other 
devices such as supervisory or alarm systems or 
safety or limit controls intended to warn of, or protect 
against, failure or malfunction of the FX40. 

Mount the FX40 controller in a location that allows 
clearance for wiring, servicing, and module removal. 
For mounting details refer to Figure 2. 

Follow these recommendations and precautions when 
mounting and installing the unit. 

• Use this controller for indoor use only. Do not 
expose the unit to ambient conditions outside the 
range of 0 to 50ºC (32 to 122ºF) and relative 
humidity outside the range of non-condensing 
5 to 95% (Pollution Degree 1). Static Discharge Precautions 

Static charges produce voltages high enough to 
damage electronic components. The microprocessors 
and associated circuitry within an FX40 controller are 
sensitive to static discharge. 

• For a controller mounted inside an enclosure, 
ensure that the enclosure is designed to keep the 
unit within its required operating range 
(considering a 20-watt dissipation by the 
controller). This is especially important if the 
controller is mounted inside an enclosure with 
other heat producing equipment. 

Important Work in a static-free area. Discharge 
any static electricity you may have accumulated. 
Discharge static electricity by touching a known, 
securely grounded object. Do not handle the Printed 
Circuit Board (PCB) without proper protection 
against static discharge. Use a wrist strap when 
handling PCBs. Secure the wrist strap clamp to 
earth ground. 

• Provide a minimum 0.2 inch clearance from the 
wall where the unit is mounted (provided by the 
dimpled mounting feet). Ensure that this space is 
not compromised and that airflow is not blocked 
behind the unit. 

• Do not mount the unit: 
− in an area where excessive moisture, 

corrosive fumes, or explosive vapors are 
present 

− where vibration or shock is likely to occur 
− in a location subject to electrical noise. This 

includes the proximity of large electrical 
contactors, electrical machinery, welding 
equipment, and spark igniters. 

• Mount the controller on a wall with the battery 
situated towards the bottom of the unit. For proper 
airflow at temperature extremes, do not mount the 
unit oriented in any other way.
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Figure 2: Mounting Details
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Replacing the Cover of an FX40 Removing and Replacing the Cover 1. Align the hinge tabs on the cover with the hinge 
slots on the left wall of the metal casing.  The FX40 cover is removable. The cover is secured in 

place with a knurled-edge, slotted-head screw. 
2. Slide the hinge tabs into the slots.  

If you need a more secure installation for the cover, 
use a padlock through the security tab that protrudes 
through the cover. 

3. Slide the door toward the bottom of the unit until 
the bottom of the hinge tabs hit the bottom of the 
slots.  

Removing the Cover of an FX40 4. Loosen and remove the nut and locking washer on 
the grounding strap post on the door.  1. Loosen the cover screw and open the cover. You 

may need a flat-blade screwdriver to loosen the 
cover screw. 5. Slide the ground strap onto the screw post and 

replace the locking washer and then the nut. 
Tighten.  2. On the inside of the door, loosen and remove the 

nut and locking washer that secures the green 
grounding strap to the cover.  6. Close the door and tighten the security screw. 

3. Pull the grounding strap off the screw post.  Board Layout 
4. Replace the locking washer and then replace the 

nut on the screw post. Tighten.  
See Figure 3 for location of communication ports, 
Light-Emitting Diodes (LEDs), and other features of 
the FX40. 5. Close the door about half way.  
 6. Slide the cover toward the top of the unit until the 

tops of the hinge tabs on the cover hit the top of 
the hinge slots on the left wall of the metal 
enclosure.  

7. Slide the hinge tabs out of the slots. 
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Figure 3: FX40 Board Layout Details
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Wiring Details Important Use copper conductors only. Make 
all wiring connections in accordance with local, 
national, and regional regulations. Do not exceed the 
FX40 electrical ratings. 

See Figure 3 to locate connectors and other 
components on the FX40 controller.  

Make connections to the FX40 in the following order.  
 

1. With the 6-position power connector disconnected 
from the board, wire the power to the transformer. 
See Power Wiring. 

Important Do not attempt to use any other 
power source or otherwise defeat the isolation 
provided by the integral transformer. A two-wire 
power source, including a 24 V transformer, can 
cause permanent damage or greatly shorten the life 
of the unit.  

2. Connect communications cables. See 
Communication Wiring. 

3. Connect the Input Output (I/O) wiring. See I/O 
Wiring.  

Important Verify that the secondary side of the 
transformer is not grounded or connected to building 
neutral. Connecting the secondary side of the 
transformer to ground or building neutral may cause 
improper operation of the system.  

4. Apply power to the unit. See Power Up and Initial 
Checkout. 

Power Wiring 
Building power is wired directly to the transformer 
supplied with the FX40. There is no disconnect switch 
in the unit; therefore you should wire the FX40 to an 
external switch or breaker. Some local codes require 
the switch to be in sight of the unit. The switch must be 
capable of 120 VAC plus sufficient capacity for test 
equipment. 

Making the Power Connection to the Transformer 
With the 6-position power connector disconnected 
from the PCB, unscrew the nut and locking washer 
and remove the metal enclosure of the transformer. 

Note: As required by code, high voltage Class 1 
wiring must be confined behind the transformer’s 
enclosure divider. Make sure to replace this barrier 
after you complete the wiring. Do not pinch wires 
underneath the barrier when you reinstall the barrier. 

About the Transformer 
The FX40 ships with a 120 VAC, 50/60 Hz transformer 
and 12 V battery.  

The transformer provides power to the controller in a 
14-CT-14 configuration (28 VAC center tapped). The 
power connector has been disconnected for shipping. 

Using the provided wire nuts, connect 120 VAC 60 Hz 
power to the transformer and power connector using 
the information in Table 2.

Important Do not power other devices from the 
transformer of the FX40. The transformer should be 
dedicated to running the FX40. Powering other 
devices from the transformer could cause improper 
operation of the FX40. 

Table 2: US Models - Building Power Terminations 

Type of Wire Typical Color of Wire Termination Point 
Ungrounded-Hot Black Either wire of the 120 V transformer 
Grounded-Neutral White Other wire of the 120 V transformer 
Grounding-Ground (Earth) Green or bare copper Grounding stud 
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Communication Wiring 
All communications wiring is made through knockouts 
adjacent to the communication ports. Before you 
connect cables, ensure that the grommet bushing has 
been installed for each knockout. Employ strain relief 
on the communication wiring to prevent damage to the 
controller. 

Ethernet 
A single, female 10/100 Mbit Ethernet connection is 
provided on the controller. This connection is capable 
of running at either 10 Mbps or 100 Mbps; it 
automatically adjusts to either speed. This means the 
FX40 can exist on the same network with a mixture of 
10BaseT and 100BaseTX hardware connected to a 
smart 10/100 hub capable of adjusting to the devices it 
supports.  

Connection is made via a standard male RJ-45  
(8-wire) connector. Using a Category 5 Unshielded 
Twisted Pair (UTP) cable, connect one end of the 
cable through the knockout adjacent to the RJ-45 
connector on the FX40. Connect the other end to a 
hub on the Ethernet Local Area Network (LAN). 

The maximum end-to-end distance from the controller 
to the hub is 328 feet (100m). 

Serial 
There are two serial ports on the FX40 (see Figure 3). 
The top serial port is an RS-232 port using an RJ-45 
connector. The serial port beneath the RS-232 port is 
a two-wire with shield, non-isolated RS-485 port. 

RS-485 multi-point connections are made to the  
3-position, screw terminal connector on the board. 
Wire to this connector with shielded 18-22 AWG wiring 
(refer to the TIA/EIA-485 standard). The screw 
terminals (from top to bottom) are shield, plus (+), and 
minus (–).  

An RS-232 serial port connection can be made to the 
female (socket) RJ-45 connector using an  
8-conductor flat silver satin stranded cable with 
standard male (plug) RJ-45 connectors. Connect the 
flat satin cable (maximum distance 50 feet) through 
the enclosure knockout nearest the port. This 
straight-through cable is then connected to a  
socket-to-socket type RJ-45 to DB-9 adapter. 

The FX40 is a serial Data Terminal Equipment (DTE) 
device. Other DTE devices (computer, for example) 
require a null modem adapter (part number 
LP-KIT408A-0, optional item). If you connect the FX40 
to a Data Communications Equipment (DCE) device 
(modem, for example), a straight-through adapter is 
used. Table 3 provides pinouts for both types of RJ-45 
to DB-9 adapters. 

Note: 

Note: 

Silver satin cables are not standard Ethernet 
UTP cable, in which the pairs are twisted around each 
other. The twisting of the pairs may cause undesirable 
effects on the serial communication. We recommend 
the use of flat silver satin cable instead. 

Flat silver satin cables are unshielded. If you 
install this cable in a noisy electrical environment, run 
the cable through conduit, with no other wires in that 
conduit. 
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Table 3: RJ-45 to DB-9 Adapter Pinouts 

RJ-45 and DB-9 
Pinout References  

Type of 
Adapter 

RJ-45 
Socket Pin 

Signal  DB-9 Socket Pin 

5 DCD Data carrier detect 1 
3 TXD Transmit data 2 
6 RXD Receive data 3 
8 DSR Data set ready 4 
4 GND Ground 5 
1 DTR Data terminal ready 6 
7 CTS Clear to send 7 
2 RTS Request to send 8 

RJ-45 Socket (female) 

18  

Null Modem 
(for connecting to 
another DTE 
device) 
Part number 
LP-KIT408A-0 

— not used on the FX40 9 
5 DCD Data carrier 

detect 
1 

6 RXD Receive data 2 
3 TXD Transmit data 3 
1 DTR Data terminal 

ready 
4 

4 GND Ground 5 
8 DSR Data set ready 6 
2 RTS Request to send 7 
7 CTS Clear to send 8 

DB-9 Socket (female) 

15

9 6  

Straight-through  
(for connecting to a 
DCE device) 
 

— not used on the FX40 9 

LONWORKS Connection 
A single, two-pin, male LONWORKS FTT-10A 
Weidmuller connection is provided on the controller. 
This connection supports twisted pair, unshielded, 
polarity-insensitive, peer-to-peer communications at 
78 Kbps. 

Refer to the LONWORKS FTT-10A Free Topology 
Transceiver User’s Guide (078-0156-01F) for technical 
guidelines associated with free topology restrictions. 
Refer to the Junction Box and Wiring Guidelines for 
Twisted Pair LONWORKS Networks (005-0023-01) for 
more detailed information on wiring specifications. 
These documents are available on the Echelon® Web 
site (www.echelon.com). 

Modem (Optional) 
The female RJ-11 connection for the modem is located 
below the RS-485 port. Connect one end of a standard 
flat satin telephone cable (4-connector) through the 
adjacent knockout to the modem’s RJ-11 connector. 
Connect the other end to an analog telephone port. 

This modem is approved for US use only, and must be 
tested for use in other countries. 

I/O Wiring 
The FX40 provides six (6) universal inputs supporting 
analog inputs (temperature, resistance, voltage, and 
current) and digital inputs (contact closure, pulse 
count), as well as four (4) form-C Single-pole 
double-throw (SPDT) relay outputs. 

See Figure 3 for the location of these inputs and 
outputs. 

Inputs 

Thermistor 
The inputs support Type 3 10K Thermistor 
temperature sensors with a sensor range of  
10 to 135°F (23.3 to 57.2°C), using the appropriate 
Niagara object. Input accuracy is in the range of ±1% 
of span. Figure 4 shows the wiring diagram. 

Shielded, Twisted Cable, 
61m (200 ft) maximum

Stud in 
enclosure

Shield

10K Thermistor

 
Figure 4: Thermistor Wiring 

FX40 Installation Instructions    9 



  

Note: Universal inputs are optimized to provide the 
best resolution around the 10K ohm range. For a 
sensor with a range far from 10K ohms (such as a 
100-ohm or 1000-ohm type), resolution is poor. If you 
use this sensor, we recommend that you install a 
transmitter that produces a Vdc or mA signal, and then 
wire the transmitter to the User Interface (UI) 
according to the 0–10 Vdc or 4–20 mA. 

 Resistive 
The inputs support resistance inputs with a range of 
0-100K ohms. Input accuracy is in the range of ±1% of 
span. 

Stud in 
enclosure

Shield

Resistance
Range: 0—100K ohms

Shielded, Twisted Cable, 
61m (200 ft) maximum

 

Figure 5: Resistive Wiring 

0–10 Vdc 
The inputs support self-powered 0–10 Vdc sensors. 
Input impedance must be greater than 5K ohms.  
0–10 volt accuracy is ±2% of span without user 
calibration. Figure 6 shows the wiring diagram 

Shielded, Twisted Cable, 
61m (200 ft) maximum

Stud in 
enclosure

0—10Vdc Sensor

Range: 0—10 Vdc Input Impedance > 5K ohms

0—10
Vdc

(self-powered sensor)

 

Figure 6: 0-10Vdc Wiring 

4–20 mA 
The inputs support self-powered or controller-powered 
4–20 mA sensors. For controller-powered sensors, the 
controller’s two V+ terminals supply 20 Vdc, at up to 
80 mA combined. Input accuracy is ±2% of span 
without user calibration. The input requires an external 
499-ohm resistor for current input (six are supplied 
with the unit). Figure 7 shows wiring used for a 
self-powered sensor (top) and a 2-wire 
controller-powered sensor (bottom). 

Shielded, Twisted Cable, 
61m (200 ft) maximumStud in 

enclosure Shield

4—20 mA Sensor

Range: 0—20 mA

(self-powered sensor)

Shielded, Twisted Cable, 
61m (200 ft) maximum

Shield

Range: 0—20 mA

499 Ohm 
resistor
(supplied 
with unit)

4—20 mA Sensor

(controller-powered sensor)

499 Ohm resistor
(supplied with unit)

Stud in 
enclosure

Self
Powered

Controller
Powered

 

Figure 7: 4-20 mA Wiring 
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Note: Binary Input 
The inputs support both pulse contacts and normal dry 
(equipment status) contacts. Figure 8 shows the wiring 
diagram. 

• Pulse contacts may have a change-of-state (COS) 
frequency of up to 20 Hz with a 50% duty cycle. 

The minimum dwell time must be > 25ms. 

• Standard dry contacts must have a 1 Hz. (or less) 
COS frequency, with minimum dwell  
time > 500ms. 

Both types of dry contacts support 3.3 Vdc open 
circuits or 330 µA short-circuit current.  

 

Shielded, Twisted Cable, 
61m (200 ft) 

i
Stud in enclosure 

Shield

Pulse 
Range: 20 Hz, 50% Duty Cycle
Minimum dwell time > 25ms

Shielded, Twisted Cable,
61m (200 ft) 

i
Stud in enclosure 

Shield

Dry Contacts 

 

Figure 8: Binary Input Wiring 
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Outputs 
Four (4) form-C relay outputs provide isolated 
dry-contact control of 24 VAC/DC loads at up to 2A 
resistive. An LED indicator for each relay is located 
between the relay and the wiring connection point 
(see Relay Output Status). Figure 9 shows example 
wiring diagrams. 

 

(loads energized if 
FX40 loses power)

Loads 
24Vac
at 2A 
resistive 
max

24 VacAC Mains
(Line)

Normally Open (N.O.)

(loads de-energized if 
FX40 loses power)

Loads 
24Vac
at 2A 
resistive 
max

24 Vac
AC Mains

(Line)

 

Figure 9: Example Relay Output (RO) Wiring 

Power Up and Initial Checkout 
Ensure that power wiring to the transformer is 
complete before you proceed (see Power Wiring). The 
FX40 controller does not include an On/Off switch. To 
apply power, insert the 6-position power connector to 
the board. See Figure 3 for the locations of the power 
connector and status LEDs on the FX40 controller. 

Checking the Heartbeat LED 
When you first supply power to the controller, the red 
heartbeat LED comes on solid for about 10 seconds 
and begins to blink. The blink pattern of the heartbeat 
LED under normal operation differs for each 
installation (depending on station activity). But, in 
general, the LED should blink about once per second. 
The rate is slower when the control engine executes 
the station database and as more objects are added. 

After you apply power to the controller, if the heartbeat 
LED comes on and stays lit longer than two minutes, 
contact a Facility Explorer technical support resource. 
See also Using Status LEDs. 

About the Battery 
The FX40 comes with a sealed lead acid battery that is 
nearly charged. Therefore, the FX40 has battery 
backup protection immediately upon installation. If 
battery trouble messages appear upon power up, 
contact a Facility Explorer technical support resource. 

For more information about the use and replacement 
of the battery, see Required Battery Maintenance. 

Using Status LEDs 
The FX40 controller includes a series of LEDs that 
indicate power and communication status. You can 
locate them on the circuit board. See Figure 3 for the 
exact locations of status LEDs on the FX40 controller. 

LONWORKS Port 
Two LEDs are located below the LONWORKS port.  

• The yellow transmit LED (TxD) indicates that the 
FX40 is transmitting a message on the LONWORKS 
trunk. 

• The green receive LED (RxD) indicates that 
another LONWORKS device is transmitting a 
message. 
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Ethernet Port 
The Ethernet port has two green LEDs, located below 
the Ethernet connector.  

• The LED marked 100 indicates whether the FX40 
is operating at 10 Mbps (Ethernet) or 100 Mbps 
(Fast Ethernet). If the 100 LED is on, the network 
connection is operating at 100 Mbps. Otherwise, 
the port is communicating at 10 Mbps. 

• The ACT LED indicates activity on the port as 
follows: 

− Off-No Ethernet link is made. 

− On-Ethernet link is present, but there is no 
activity on the LAN. 

− Blinking-Ethernet link is present with data 
activity on the LAN. 

Heartbeat 
The BEAT LED is located below the Ethernet status 
LEDs, and is red. Under normal operation, this LED 
should blink about once per second. Blink patterns 
differ as station activity varies, but any pulse rate from 
once per second to 10 blinks per minute usually 
indicates normal operation. If the heartbeat LED stays 
on constantly, does not light, or blinks very fast (more 
than once per second), contact a Facility Explorer 
technical support resource. 

Serial Ports 
The status LEDs for the serial ports are located below 
the respective RS-232 and RS-485 ports. They are 
marked COM1 and COM2 and correspond to the 
software configuration on the COM ports. They show 
the transmit and receive information for the serial 
ports and optional modem. 

• The yellow transmit LED indicates that the FX40 
is sending data out the serial port over a 
communications line to a connected device.  

• The green receive LED indicates that the FX40 is 
receiving data from a connected device. 

These LEDs are driven by pulse detectors that provide 
a fixed on-time when data is detected on the port. If 
these LEDs are on constantly, this indicates a problem 
with the communications channel (for example, a 
shorted wire or reversed wiring). 

Modem 
The modem LED is located directly above the RJ-11 
connector for the modem, and is green. When lit, it 
indicates that the modem is connected to another 
modem (a carrier is detected). In this case, the serial 
port LEDs for COM2 should indicate transmit and 
receive activity—see Serial Ports.  

Relay Output Status 
There are four (4) relay output status LEDs. These are 
yellow LEDs, with each one located below the 
associated form-C relay (just above the screw 
terminals for each output’s wiring). 

Under normal operation, a relay status LED indicates 
activity as follows: 

• Off-Relay coil is not energized. 

• On-Relay coil is energized. 

Therefore, for a circuit with a normally open contact, 
an On status indicates that the contact is closed. For a 
circuit with a normally closed contact, an On status 
indicates that the contact is open. 

Maintaining the FX40 

Cleaning 
If dust or metal filings are present inside the unit, clean 
with vacuum or compressed air. Otherwise, no 
cleaning inside the unit is required. Optionally, if the 
outside of the metal enclosure becomes dirty, you can 
wipe it with a damp cloth and mild detergent. 

Required Battery Maintenance 
Battery life expectancy is a function of its discharge 
cycles (the number of discharges and their depth) and 
the ambient temperature of the battery during normal 
operation. In most applications, the battery should see 
relatively few discharges. Therefore, ambient 
temperature has more to do with determining the life 
expectancy of the battery than any other factor. If the 
FX40 is installed in a conditioned space, the battery 
should provide dependable service for approximately 
3 years. In an environment where the operating 
temperature is higher (50ºC or 122ºF), you should only 
expect the battery to last approximately 1 year. 

The sealed lead acid battery in the FX40 controller is 
nearly fully charged before shipping. The battery is 
automatically float-charged during normal operation 
(while power is applied to the unit). The FX40 monitors 
the battery and periodically loads the battery to test its 
ability to maintain battery-backed functions. You 
should investigate any battery trouble message. Check 
the voltage level and its connections to the unit. 
Replace the battery as required. 
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To order a new battery, see Standard Replacement 
Parts. 

Replacing the Battery 

Important Maintain proper polarity when 
replacing the battery of the unit. Although the FX40 
is fully protected against shorted battery terminals, 
the battery itself is not internally protected. Use 
extreme care to not short circuit the battery. A 
shorted battery may overheat rapidly and damage 
the harness or cause other physical harm to the 
hardware. 

Replacing an FX40 Battery 
To replace the battery, do the following: 

1. Unplug the 6-position power connector. Do not 
remove the male connector from the wiring 
harness. 

2. Using a 7 mm (1/4-inch) nut driver, unscrew the 
lock nut from the bracket that is holding the 
battery. 

3. Hold the battery in place while you remove the 
bracket that secures it to the bottom of the unit.  

4. Disconnect the two quick connect terminals on 
the battery.  

Note: 

Note: 

The FX40 will lose its time and date settings 
if it is disconnected from both battery and AC 
power for more than one hour. 

5. Remove the old battery and recycle as defined by 
your regional codes. For recycling within the US, 
see the labeling on the battery. 

6. Connect the quick connect terminals to the new 
battery. Make sure the RED (+) wire is connected 
to the positive terminal of the battery and the 
BLACK (–) wire is connected to the negative 
terminal.  

7. Secure the new battery to the bottom of the unit 
with the bracket and tighten the lock nut. 

8. Plug the power connector in and verify normal 
operation. 

NiagaraAX Software Installation 
As shipped from the factory, FX40 controllers are 
pre-configured with a Niagara build, license, and three 
Johnson Controls® specific Java® Archive (JAR) files. 
With those components in place, you should only have 
to change login credentials and Internet Protocol (IP) 
settings (per network requirements) to set up the FX40 
controller. This document provides step-by-step 
instructions for these tasks. 

The most straightforward way to set up an FX40 
controller (and to upgrade to a newer Niagara build at 
a later date) is to use the administrative tools available 
under the Tools Menu in the FX Workbench. 

If upgrading JAR files with patches at a later 
date, use the Update Remote Site menu item. If 
upgrading to a newer Niagara build, use the Upgrade 
Remote Software Version menu item. If changing login 
credentials, use the Change Remote Login Credentials 
menu item. 

Preparing for Setup 

Providing Power and Connectivity 
Perform the initial startup of an FX40 in your office, 
before physically mounting it in place at a job site. 

After you complete the commissioning process, mount 
and wire the FX40 controller at the job site, making 
permanent mounting and wiring connections. 

For this initial Ethernet connection, you can use one of 
the following: 

• a crossover cable connected directly between your 
computer and the FX40 

• a normal Local Area Network (LAN) connection, 
meaning that both your computer and the FX40 
are physically connected to the same Ethernet hub 
or switch. 

IP Address 
When shipped, a new FX40 series controller is 
pre-configured with an IP address of 192.168.1.149 
with a default subnet mask of 255.255.255.0. 

To change the IP settings, perform the following steps: 

1. Use the Windows Network Connections utility on 
your workstation to configure your Transmission 
Control Protocol/Internal Protocol (TCP/IP) 
settings with an IP Address of 192.168.1.100 and 
Subnet Mask of 255.255.255.0. 

2. Make an Ethernet connection to the FX40 as 
indicated in Providing Power and Connectivity. 

3. Run the FX Workbench application. 

4. Under the File Menu, select the Open Remote 
Station menu item. When prompted, enter the 
Remote Site Address (i.e. 192.168.1.149), the 
Remote Username (i.e. jci), the Remote 
Password (i.e. explorer) and click OK. When the 
Authentication dialog appears, enter the 
Username (i.e. admin), leave the Password field 
empty, and click OK. 
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5. The station running on the FX40 opens up in the 
FX Workbench application, which has a 
Navigation Tree on the left and a Display Window 
on the right. Click the IP Config tab above the 
Display Window to access the TCP/IP 
Configuration screen. 

6. On the TCP/IP Configuration screen, make sure 
the Interfaces field is expanded so that the IP 
Address and Subnet Mask fields appear. Modify 
the Gateway, IP Address, and Subnet Mask 
fields, and click Save. When prompted to Reboot 
Now, click Yes. Give the FX40 a couple minutes 
to reboot and restart the station that is installed. 

Note: If the following message appears, just click 
OK. The changes are saved anyway. 

 

Platform Daemon Credentials 
An FX40 series controller is shipped with the following 
platform daemon (administrator) credentials: 
username jci and password explorer. 

Initially, you use these default credentials to open a 
platform connection (log in) to the FX40. Like the 
factory-assigned IP address, default credentials are 
intended to be temporary. You should change these 
credentials to be something unique, and guard them 
closely. 

To change the Platform Daemon credentials, perform 
the following steps: 

1. Run the FX Workbench application. 

2. Under the File Menu, select the Open Remote 
Station menu item. When prompted, enter the 
Remote Site Address (e.g. 192.168.1.149), the 
Remote Username (i.e. jci), the Remote 
Password (i.e. explorer) and click OK. When the 
Authentication dialog appears, enter the 
Username (i.e. admin), and leave the password 
field empty, and click OK. 

3. In the Login Credentials dialog, enter the new 
Username, Password, the Confirm Password 
field, and click OK. The next time you log into the 
FX40, use these new credentials. 

Restoring a Backed Up Station 
If the FX40 ever gets into an erroneous condition 
where you cannot fix a station, you can restore a 
previously backed up station by using the Restore 
Backed Up Station menu item under the Tools menu. 

To restore a backed up station, perform the following 
steps: 

1. Run the FX Workbench application. 

2. Under the File Menu, select the Open Remote 
Station menu item. When prompted, enter the 
Remote Site Address (for example, 
192.168.1.149), the Remote Username, the 
Remote Password and click OK. When the 
Authentication dialog appears, enter the 
Username, Password (optional), and click OK. 

3. In the Restore Backed Up Station dialog, enter 
the Remote Site IP Address, Remote Username, 
Remote Password, select the .dist (station 
backup) file, and click OK. This reboots the FX40 
automatically. 

Note: You can back up a station by using the 
Backup Station menu item from the station node’s 
popup menu in the Navigation Tree. We 
recommend that you back up a station daily to 
minimize the chance of information loss. 

Replacement Parts 
Servicing the FX40 may call for replacement parts. 

Non-Replaceable Parts 
Other than the parts listed in the replacement parts 
sections, there are no serviceable components on the 
base assembly. 

Memory 
No addition, modification, or replacement of memory 
components is allowed. 

Fuses 
The FX40 has two 250V, 2.5A delay (series 372) fuses 
on the printed circuit board. These fuses are Wickman 
F015-2.5A250V fuses. However, on-board power 
circuit protection is not user-serviceable.  

Standard Replacement Parts 
Standard replacement parts are listed in Table 4. 
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Table 4: Standard Replacement Parts  

Part Number Description 
LP-KIT402A-0 Battery, 12 Vdc, 1.2 AH (see Replacing the Battery.) 
LP-KIT403A-0 FX40 hardware accessory package which includes: 

• 499 ohm, 1%, six 0.6w resisters  
• four 6-position I/O screw terminal connector plugs 
• 3-position RS-485 screw terminal connector plug  
• two wire nuts 
• LONWORKS 2-position screw terminal connector plug  

LP-KIT407A-0 Battery/ground harness (also includes 6-position power connector) 
LP-KIT408A-0 Adapter, RJ-45 to DB-9 null modem, for serial port to connect to DTE device 
LP-KIT409A-0 Silver satin patch cable, 4 feet (used between adapter and serial port) 
LP-KIT410A-0 Silver satin patch cable, 10 feet (used between adapter and serial port) 
LP-KIT411A-0 Silver satin patch cable, 25 feet (used between adapter and serial port) 
LP-KIT401A-0 On-board auto dial/auto answer 56k modem  
LP-KIT400-700 Replacement FX40 circuit board 

Replacing the Modem 

Important Work in a static-free area. 
Discharge any static electricity you may 
have accumulated. Discharge static 
electricity by touching a known, securely 
grounded object. Do not handle the Printed 
Circuit Board (PCB) without proper 
protection against static discharge. Use a 
wrist strap when handling PCBs. Secure the 
wrist strap clamp to earth ground. 

To replace the modem, proceed as follows: 

1. Open the cover of the unit. 

2. Unplug the 6-position power connector. 
Do not remove the male connector from 
the wiring harness. 

3. Unplug the RJ-11 telephone wire from the 
modem’s RJ-11 connector. 

4. Remove the old modem as follows: 

a. Locate the on-board modem (see 
Figure 3) and note the following: 

Orientation of the sockets for the pins 
on the modem - the sockets are two 
parallel lines. The socket for Pin 1 
(noted on Figure 3) is the left-most pin 
on the bottom line. 

Orientation of the writing on the 
modem. Writing on the replacement 
modem will be the same. 

b. Place the blade of a flat-blade 
screwdriver under the left end of the 
modem between the pin sockets. 

c. Gently pry the modem up about 3 mm 
(1/8th inch). 

Note: Do not try to completely 
remove the modem with this step. 
Doing so may damage the pins. 

d. Place the blade of the screwdriver 
under the right end of the modem and 
gently pry the modem up about 3 mm 
(1/8th inch). 

e. Repeat Steps b-d until the modem is 
out of its socket. 

5. Insert a new modem as follows: 

a. Locate Pin 1 on the modem. If you are 
reading the writing on the modem, 
Pin 1 is the first pin in the lower left 
cornesr. It is marked with a small black 
dot on the top of the modem. 

b. Locate the socket for Pin 1 on the 
board (see Figure 3). 

c. Orient the modem so that Pin 1 of the 
modem is over the socket for Pin 1. 
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Note: Use the white trace lines on 
the board to help align the modem. 
When the modem is correctly aligned, 
the trace lines outline the modem 
completely. 

d. Push the modem into the sockets 
using your thumbs. All pins should be 
properly inserted. 

6. Plug the RJ-11 telephone wire into the 
modem’s RJ-11 connector. 

7. Plug the power connector in and verify 
normal operation. 

Replacing the FX40 Circuit Board 

Important The surface-mounted 
components on the circuit board are small. 
Improper handling may cause the 
components to break or become damaged 
during the removal or replacement of the 
circuit board. 

 

Important Do not use a nut driver to 
replace the FX40 circuit board. A nut driver 
causes board damage to adjacent 
components. Use a 1/4” (7mm) thin-walled 
socket instead. Carefully loosen or tighten 
the nuts that secure the FX40 board to the 
seven mounting studs. 

 

Important Use only the spacers that are 
supplied with the FX40. Using other spacers 
may cause damage to the FX40 and will 
void the warranty.  

 

Important Work in a static-free area. 
Discharge any static electricity you may 
have accumulated. Discharge static 
electricity by touching a known, securely 
grounded object. Do not handle the Printed 
Circuit Board (PCB) without proper 
protection against static discharge. Use a 
wrist strap when handling PCBs. Secure the 
wrist strap clamp to earth ground. 

To replace the FX40 circuit board, proceed as 
follows: 

1. Using FX Workbench, back up the station 
database to your personal computer. 

2. Open the cover of the unit. 

3. If any of your I/O points have voltage, turn 
the devices off or disconnect power to 
them. 

4. Turn off building power to the unit. The 
unit should power down automatically. 

5. Unplug the 6-position power connector 
from the board. 

6. Note positions of all communications and 
I/O connectors going to the circuit board. If 
necessary, label connectors to avoid 
misconnection later (after circuit board is 
replaced). 

Note: The software that runs on the unit 
expects the terminal positions to be the 
same to collect data from or to control the 
attached devices. 

7. Unplug all Ethernet, serial, I/O, modem, 
and LONWORKS connectors from the 
circuit board. 

8. Using a 1/4" socket, carefully remove and 
retain the seven 1/4" nuts securing the 
circuit board. Be mindful of small 
surface-mount components located near 
board mounting points. 

9. Remove the old circuit board. Make sure 
that metal spacers (behind the board) 
remain on the seven mounting studs. 

10. Replace the new circuit board on the 
mounting studs and spacers, carefully 
securing with the seven 1/4" nuts. Again, 
be mindful of small surface-mount 
components located near board mounting 
points. 

11. Turn on building power to the unit. 

12. Plug the 6-position power connector in 
and verify normal operation. 

13. Reconnect any Ethernet, serial, modem, 
and LONWORKS connectors. 

14. Reconnect all I/O connectors. 
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15. If any of your I/O points have voltage, 
turn the devices back on, or reconnect 
power. 

16. Using FX Workbench, re-commission the 
FX40: 

a. Install the correct Niagara release and 
set the date and time. 

b. Install the new license file. 

c. Restore the station database and start 
the station. 

 

 
 
Controls Group 
507 E. Michigan Street 
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Milwaukee, WI 53201 Published in U.S.A and Europe
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